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A WORD ABOUT THIS GAME

We would like to thank you for purchasing one of our
products. For your convenience you can make backups in
order to protect your investment. Please remember that
the developers of this product are relying on you not to
give away copies to others. They have spent a lot of time,
effort and money to bring this software to you, and are
relying solely upon royalties from sales in order to make a
living. Your purchase will allow them to invest the time
and energy necessary to produce additional high quality
software in the future.

We are committed to providing products for you that are
of the highest quality and value. If you have questions
concerning any of our software, or if there are additional
programs that you would like to see developed, please con-
tact us through any of the means indicated on the next
page.

Alept llen
Phillip G. Adam, President
Sphere, Inc.

Gilman G. Louie, CEO
Sphere, Inc.



Republic: Armenia
Area: 11,500 sq. mi.
Capital: Yerevan

Republic: Azerbaijan
Area: 33,400 sq. mi.
Capital: Baku
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INTRODUCTION
WELLTRIS™ presents another challenge to the
western world from the Russian gamemasters.
Coming to us from the Soviet Union on the
heels of its award-winning predecessor,
TETRIS', WELLTRIS, in a satisfying display of
glasnost (openness), is made available to
American gameplayers through the efforts of
Spectrum HoloByte. These games represent a
significant glasnost initiative towards the nor-
malization of East-West relations and point up
the ongoing Soviet fascination with free enter-
prise and individual initiative.
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A Word About the Master:
Alexey Pajitnov

Alexey Pajitnov of the Soviet Academy of Sci-
ences created both TETRIS and WELLTRIS. The
33-year old inventor lives in a modest Moscow
apartment with his wife and two children - the
only American-style high-tech electronic appli-
ance is his own personal computer. Such an
expensive device (roughly the price of a country
home) is still rare in the Soviet Union, but
Pajitnov and a growing group of others at the
Academy will inevitably change this.

Pajitnov is part of the computer revolution in
Russia. The control of a personal computer is
the control of your own knowledge - a neces-
sary adjunct to controlling your own life.

The international success of his games has
helped make one of Pajitnov's fondest wishes
come true. He has recently completed a tour of
Japan and United States, sponsored by the many
companies that have brought his games to you.

System Requirements
To play WELLTRIS in black-and-white, you
must have a Macintosh running System 4.1 or
later. To play the color game, you must have a
Macintosh II series machine with 2MB RAM,
an 8-bit color card, a hard disk with. at least
1.5MB free, a monitor with 256-color capability
and System 6.0.2 or higher. The black-and-
white version will work on a color monitor.

We assume that you already know how to
load programs into your Macintosh. If this is
your first game for your first Mac, please check
your manual for the correct procedures.

Be sure to back up the 800K disk(s) that you
use in your machine. Play the game with the
backup or on your hard drive; keep the original
800K disk(s) ready for emergencies.

Republic: Belorussia
Area: 80,200 sq. mi.
Capital: Minsk

Republic: Estonia
Area: 17,400 sq. mi.
Capital: Tallinn



Republic: Georgia
Area: 26,900 sq. mi.
Capital: Tbilisi

Republic: Kazakhstan
Area: 1,049,200 sq. mi.
Capital: Alma-Ata

Republic: Kirgiziya
Area: 76,600 sq. mi.
Capital: Frunze

Republic: Latvia
Area: 24,600 sq. mi.
Capital: Riga
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Loading Mac WELLTRIS
There is no difference between loading the
black-and-white Mac WELLTRIS and any other
Macintosh program. Just boot up your Mac, put
Disk 1 in the drive, click on the disk icon and
choose the application WELLTRIS.

If you want to copy the black-and-white
game to another disk or hard drive, create a
WELLTRIS folder and copy the WELLTRIS file
and the WELLTRIS SOUNDS folder into that
folder.

If you are playing the color game, you must
first install the game onto your hard disk. Create
a folder for the game (you pick the name of the
folder) and insert Disk 2. Double-click on the
file COLOR WELLTRIS INSTALL and follow the
instructions given to install the color game and
place it into the newly created folder on your
hard disk. Then insert Disk 1 and copy the entire
folder labelled WELLTRIS SOUNDS (which must
retain that name) from Disk I to the folder.

Double-click on COLOR WELLTRIS and the

opening screen of the game is displayed; you are
now ready to play.

This program is being distributed in a Stufflt
archive. Stufflt is a file compression, encryp-
tion and file archival utility by Aladdin
Systems. If you are interested in obtaining a
copy, send US$25 to: Aladdin Systems, Deer
Park Center, Suite 23A-171, Aptos, CA
95003, USA.

Stuffit is © 1988, 1989 and is a trademark
of Raymond Lau.

WELLTRIS cannot be installed as a desk
accessory. It can be accessed through MultiFin-
der, like other Macintosh programs.
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The Obiect of the Game
The object of WELLTRIS is to manipulate the
game pieces falling down the sides of the well
so that they get to the bottom of the well and fit
amongst the game pieces already at the bottom.
When segments of game pieces form a line
(either horizontal or vertical) running from wall
to wall at the bottom of the well, the line disap-
pears, giving you room to fit in more pieces. As
long as you have pieces falling and room at the
bottom of the well, the game continues.

The Game Pieces
The WELLTRIS game pieces are geometric
shapes made up of square segments. Some are
shown in the sidebar to the right. These pieces
can consist of two, three, four and five seg-
ments. The game pieces used depend on the
Level of Difficulty.

Levels of Difficulty
There are three levels of difficulty in this game;
you can pick the level you want on the Setup
Screen.

First Level: The pieces in the first level of
difficulty of the game are made up of two, three
and four squares.

Second Level: At the second level of diffi-
culty, pieces are made up of only four squares.

Third Level: At the third level of difficulty,
pieces are made up of two, three, four and five
squares.

Sample Game
Pieces
The pieces shown
below are just some
of those you must fit
together at the bot-
tom of the well.
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Opening Screens
Once WELLTRIS is loaded, you will see the Title
Screen. You can then wait until the screen
changes automatically, or press any key again to
go to the Identification Screen.

Throughout this booklet are pictures of the
flags of the republics which make up the Union
of Soviet Socialist Republies. Accompanying
the pictures are the name, area and capital of the
republic. This screen asks you a question about
the information with one of the pictures. Type in
the first four characters of the necessary word
or number to answer the question in the space

Entering the provided. When you type in the correct word(s),
Password you go to the Setup Screen. The game will not
If the password has a work unless you type in the right word(s).
hyphen or a comma,
that punctuation
should not be en-
tered. Just enter the
letters or numbers.

The Setup Screen
This screen allows you to set the level and the
speed of play of your WELLTRIS game. Click on
the level and speed you want (see pg. 9). Other
parameters of the game are set with the File and
Options menus. When you are ready to play,
click on "START GAME" or hit Return

LEVEL

SPEED

SET UPGAME

2 4 5

ДАНГЕРА
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The Playing Screen
The Picture
The picture displayed on the right of the screen
can be used as a quick reference for the speed of
the pieces falling down the well. The same pic-
tures appear for each different speed in every
level of difficulty. You can increase the speed of
falling by using the Options menu or the com-
mand key equivalents (see page 11). The speed
also increases automatically the more lines you
fill; this is indicated by a change of the picture.
The speed cannot be decreased except by start-
ing the game over again. The faster the speed,
the more points you gain for placing pieces at
the bottom of the well.
Level
This describes the difficulty level of the pieces
falling down the well. The higher the number,
the more complex the objects. There are three
levels of difficulty.
Speed
This shows the current speed of the game.
Score
This is your score for the current game.
Lines
This is the total lines you have managed to
remove from the well bottom in this game.
Next
This shows you the shape of the next piece to be
released to the well. It gives you a bit of warn-
ing about the next shape you have to accomo-
date. This foreknowledge is useful, but it
subtracts from your score for eliminating the
piece. You can toggle this feature on and off by
using the Options menu or equivalent command
key (see page 11).

Republic: Lithuania
Area: 25,200 sq. mi.
Capital: Vilnius

Republic: Moldavia
Area: 13,000 sq. mi.
Capital: Kishinyov

LEVEL
SPEED
SCORE
LIKES

2.
2

HEXT
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Republic: Russian
Soviet Federated
Socialist Republic

Area: 6,592,800 sq. mi.
Capital: Moscow

Moving the Pieces
Game pieces are moved by using the keyboard.
The File menu and Options menu shown on the
next page can be used for the game's other
functions.

In most cases, it is possible to use the
number pad that most Macs have. For those ma-
chines that do not have this feature, we also give
you corresponding letter keys. You can change
the movement mode with the Change Move
Mode option on the Options menu.

Up|Down, Right/Left Keys: This method of
moving the pieces calls for switching the move-
ment keys as you move from the horizontal to
the vertical walls. All of the squares of the game
piece must be on the new wall before you
switch keys.

Republic: Tadzhikistan
Area: 55,250 sq. mi.
Capital: Dushanbe

Along top and bottom walls
Left
Right

4 or J
6 or L

Along side walls
Up 8 or

Ending the Game Down 2 or M
You can end the Clockwise, Counter-Clockwise Keys: This
game in three ways. mode uses the same keys to move the piece no

Quit: This lets matter what wall it is on. The game piece moves
you exit the game en-in either a clockwise or counter-clockwise direc-
tirely. No score is tion, depending on the key used. In this mode,
recorded. (4] and I do not necessarily correspond to left

Restart Game: and (6] and (L do not necessarily correspond
This lets you cancel with right; the direction the piece goes dependsyour game and return on which wall you are on. On the bottom wall,
to the Startup Screen. 6 and L move the piece to the right, but move
No score is recorded. it to the left on the top wall.

Abort Game: This Clockwise (4), or Jlets you end the Counter-Clockwise (6), or [game and go to the
High Score Screen to Choose whichever mode appeals to you most;
record your score. you can toggle between them just to give

yourself more of a challenge.
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Standard Keyboard Commands: The following
commands work at all times that game pieces
are falling down the walls of the well.

Rotate [5) or k)
Drop [o) or (Spacebar

Other Game Functions
FILE MENU
These commands can be used with the keys
shown in the sidebar or brought down from the
File menu.

Abort Current Game: Ends game; records your
current score.
Restart Current Game: Starts game over; no
score recorded.

Show High Scores: Shows the current top ten
scores.
Clear High Scores: Erases the so-far recorded
scores.
Save Options: Saves your choices of level,
speed and chosen options for future games.
Reset Default Options: Restores the options
the game comes with.

Quit: Ends game; no score recorded.

OPTIONS MENU
These commands can be used with the keys
shown in the sidebar or brought down from the
Options menu.
Pause: Stops the game until you click

"continue."
Display Next Piece; See page 9.
Sound: Turns all sound on and off.
Music: Turns music on and off.
Increase Speed: See page 9.
Changé Möve Mode: See page 10.
Confirm Choices: Use this to remove the

dialog boxes that ask if you want to OK or
Cancel a command.

Republic: Turkmenistan
Area: 188,500 sq. mi.
Capital: Ashkhabad

File Edit Options
Abort Current Game
Restart Current Game 96R

Show High Scores
Clear High Scores

96H

Save Options Ж60
Reset Default Options ID

Quit 960

Republic: Ukraine
Area: 233,100 sq. mi.
Capital: Kiev

Options
Pause

/ Display Net Piece
~ Sound
~ Music

Increase Speed
Change Move Mode...
Confirm Choices

IP
IN
IS



Republic: Uzbekistan
Area: 172,700 sq. mi.
Capital: Tashkent

Example of using
the corners: The "L-
shaped" piece has
been placed in a cor-
ner. When it hits bot-
tom, the two legs of
the "L" merge, mo-
mentarily making a
three-square piece
out of a 4-square
piece. Since, in this
case, there is nothing
blocking the piece,
the two sets of two-

square pieces then
split, going in diff-
erent directions.

During
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How Pieces Fall
If not interfered with, WELLTRIS game pieces
fall one line on the wall at a time. You can move
them horizontally as they fall.

Once a game piece reaches the floor of the
well, you can no longer control a piece's
direction. However, you can still rotate it at the
last second to make it fit exactly into the space
you want to fit it into.

Using the Corners
One unique feature of this game is the use of the
corners of the well to create new shapes from
the old shapes. When a piece is wrapped around
a corner, its segments go in a direction appropri-
ate for the wall that section is on until one

segment hits an obstructing piece. Then all
segments freeze, even though the other seg-
ments may not have hit an obstruction.

When obstructing pieces are very close to the
corner, parts of the falling piece can overlap
each other, making a smaller piece out of the
original piece.

Before

After

EX
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Scoring
You get points for successfully bringing pieces
to the floor of the well. You can do this by either
controlling the piece until it has reached the
bottom or by lining it up near the top of the well
and then dropping it by using (Spacebar) or O
on the numeric keypad. You get more points the
further the piece is dropped and more points for
filling in either a horizontal or vertical line at the
bottom of the well with segments. When a line
is filled in, the computer removes the line
(giving you more room to bring down more
pieces) and increases your score. The more lines
you remove at a time, the higher your score.

The Game is Over
The game is over when you voluntarily exit it,
as described before (sidebar page 10), or if you
can no longer bring game pieces to the bottom
of the well. In this case, you have lost - though
you still get a score. You can lose the game in
one of two ways:

All four walls blocked: Pieces that come to a
stop with one or more of their sections still on
the wall cause that wall to be blocked until three
more pieces have finished falling either by
touching bottom or being caught by another
piece on the wall. No game piece will appear on
that wall and pieces cannot be moved along that
wall as long as it is blocked. If all four walls are
blocked, the game is over.

One wall with pieces stacked to the top: If
pieces are stopped on the wall and other pieces
stack up on these pieces until there are pieces
stacked the entire height of the wall, the game is
over. Players of TETRIS will recognize this as
the method by which that game is ended.

REMEMBER
High speed

high points
High level

= high points
Getting pieces to the
bottom

= points
Dropping pieces
from a high point

= more points
Removing lines

= points
Removing multiple

lines = more points
Clearing entire well

= more points
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High Score Screen
This screen shows the ten highest scores for your
WELLTRIS game. The score from the latest game is
also displayed. If you have just finished a game and
your score is higher than than the lowest score re-
corded, a space is provided for you to enter your name;
your score will be placed among the top ten scores.
Until you record ten scores, some lines will be blank.

If you want to remove previously recorded High
Scores, go to the Options menu and select the Clear
High Scores option ( # (H)).

Strategies
Use the whole well: Do not get mentally stuck on

one wall of the well. Use all four walls and keep game
pieces moving; continually check them for where they
will land. Remember that a piece skids across the
bottom until it hits an obstruction. Look for appropri-
ate obstructions for it to run into.

Build blocks of game pieces: With some judicious
maneuvering, you can build blocks of segments with
strategically placed gaps so that many lines can be
removed at once with the introduction of one piece.

Leave space for awkward pieces: Try to leave
sections of the bottom free for multi-segmented pieces
that don't fit into the blocks you're building. Fit them
up against your blocks with space to fit more mundane
pieces into and turn them into workable shapes.
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Spectrum HoloByte™ Ninety Day Limited Warranty

To the original purchaser only, Spectrum HoloByte warrants the mag-
netic diskette on which this software product is recorded to be free from
defects in materials and faulty workmanship under normal use for a
period of ninety days from the date of purchase. If during this ninety-day
period the diskette should become defective, it may be returned to
Spectrum HoloByte for a replacement without charge, provided you have
previously sent in your Warranty Registration Card to Spectrum HoloByte
or send proof of purchase of the program.

Your sole and exclusive remedy in the event of a defect is expressly
limited to replacement of the diskette as provided above. If failure of a
diskette has resulted from accident, abuse or neglect, Spectrum Holo-
Byte shall have no responsibility to replace the diskette under terms of
this limited warranty.

If the diskette should fail after the original ninety-day limited warranty
period has expired, you may return the diskette to Spectrum HoloByte at
the address noted below, accompanied by a check or money order for
the applicable replacement fee as outlined on the Warranty Registration
Card, a brief statement describing the defect, and your return address.
Spectrum HoloByte will replace the diskette provided that you have
previously returned your Warranty Registration Card to Spectrum Holo-
Byte, and the diskette retains the original product label.

ANY IMPLIED WARRANTIES RELATING TO THE DISKETTE, INCLUD-
ING ANY IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED TO A PE-
RIOD OF NINETY DAYS FROM DATE OF PURCHASE. PUBLISHER
SHALL NOT BE LIABLE FOR INDIRECT, SPECIAL, OR CONSEQUEN-
TIAL DAMAGES RESULTING FROM THE USE OF THIS PRODUCT.
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION
OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
LIMITATIONS MIGHT NOT APPLY TO YOU. THIS WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER
RIGHTS WHICH VARY FROM STATE TO STATE.
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Spectrum HoloBvte™
division of SPHERE, INC.
2061 Challenger Drive

Alameda, CA 94501
(415)522-3584

Spectrum HoloByte™ Software License Agreement

THE ENCLOSED SOFTWARE PROGRAM IS LICENSED BY SPECTRUM
HOLOBYTE™ TO CUSTOMERS FOR THEIR USE ONLY ON THE TERMS
SET FORTH BELOW. OPENING THIS PACKAGE OR USING THE EN-
CLOSED DISKETTE INDICATES YOUR ACCEPTANCE OF THESE
TERMS.

Spectrum HoloByte hereby grants you a non-exclusive license to use the
enclosed software and manual subject to the terms and restrictions set forth
in this Software License Agreement.

This manual and the software accompanying it are copyrighted, with all
rights reserved. You may not copy or otherwise reproduce any part of the
software or the manual, except that you may load the software into a
computer as an essential step in executing the software on the computer.
The original and any back-up copies of the software and the manual are to
be used only in connection with a single computer. You may physically
transfer the software from one computer to another, provided that the
software is used in connection with only one computer at a time. You may
not transfer the software electronically from one computer to another over
a network. You may not distribute copies of the software or the manual to
others. YOU MAY NOT USE, COPY, MODIFY, TRANSFER, SUBLI-
CENSE, RENT, LEASE, CONVEY, TRANSLATE, CONVERT TO ANY
PROGRAMMING LANGUAGE OR FORMAT OR DECOMPILE OR DISAS-
SEMBLE THE SOFTWARE ORANY COPY, MODIFICATION ORMERGED
PORTION, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PRO-
VIDED FOR IN THIS LICENSE.

WELMAC30 2 - 90



Name Phone (
Address
City State Zip
Program Name
Computer: L Amiga_Apple II O Apple IIGS O Atari ST O C64

DIBM [Macintosh [ Macintosh II L Tandy 1000" Other
Serial Number Version Number
Purchase Date Purchase Price
Store Name
Your Profession Age Sex
Annual Income 0 $0-24K O $25-34K D$35-50K D $50K+
Where did you hear about our product?

O Magazine - Name
• Store [Friend • Other

What similar products do you plan to purchase in the next 12 months?

What future products would you like to see from us?

READ THE REGISTRATION NOTICE BELOW AND SIGN ON THE NEXT LINE
Signature

CUT ON DOTTED LINE

Spectrum HoloBvte™
PRODUCT REGISTRATION - LIMITED WARRANTY

I understand that the materials in this package are copyrighted and that
copying (except for personal archives), modifying or transferring the mate-
rials (except where stated otherwise in the enclosed instructions) is prohibited
and a violation of copyright law.

If you fill out this product registration card and return it to us, you are covered
by your warranty. If your disk should fail within 90 days due to manufac-
turing defects, return it directly to us for a free replacement. After 90
days (or if the disk was damaged through user or machine error), return
the disk to us and enclose $7.50 for the 5.25" disk or $10.00 for the 3.5"
disk. We're sorry, but without this card we will not be able to cover you with
our warranty. (Please make a photocopy for your records and return the
original card to us.)
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What similar products do you plan to purchase in the next 12 months?
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READ THE REGISTRATION NOTICE BELOW AND SIGN ON THE NEXT LINE
Signature

CUT ON DOTTED LINE

Spectrum HoloBvte™
PRODUCT REGISTRATION - LIMITED WARRANTY

I understand that the materials in this package are copyrighted and that
copying (except for personal archives), modifying or transferring the mate-
rials (except where stated otherwise in the enclosed instructions) is prohibited
and a violation of copyright law.

If you fill out this product registration card and return it to us, you are covered
by your warranty. If your disk should fail within 90 days due to manufac-
turing defects, return it directly to us for a free replacement. After 90
days (or if the disk was damaged through user or machine error), return
the disk to us and enclose $7.50 for the 5.25" disk or $10.00 for the 3.5"
disk. We're sorry, but without this card we will not be able to cover you with
our warranty. (Please make a photocopy for your records and return the
original card to us.)
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Spectrum HoloByte"
2061 Challenger Drive
Alameda, CA 94501

This Spectrum HoloByte' program is not copy protected through any disk-based
protection schemes, which allows you to copy the program to a backup disk. As a
service to customers desiring the same program on a different disk format, we allow
our registered product owners to purchase a backup disk for the same computer
system in a different disk format. Please follow the instructions on the enclosed Disk
Exchange Order form. Please do not abuse this service by allowing others to copy
your disk.
To order by mail: Print your name, complete address and telephone number
(including area code) on a separate piece of paper. Include a description of the
product (please state the machine version) and quantity desired. Enclose a check,
money order or your Visa or MasterCard number (including expiration date) for the
exact amount. Mail the order to Spectrum HoloByte, 2061 Challenger Drive,
Alameda, CA 94501.
To order by phone (Visa or MasterCard only):

(415)522-0107 Sales Department for complete product orders
(415)522-1164 Customer Support for backup and replacement disks

For overseas orders: please write to us at the address above or call the number listed
above for overseas shipping charges.

GENERC82
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